
 AN2653
 着手使用 megaAVR 0 系列

特性

• 使用 megaAVR® 0系列单片机和工具着手设计

• ATmega4809 Xplained Pro 和 Atmel® Studio 7.0 着手设计

简介

作者：Irun Walberg，Microchip Technology Inc.

此应用笔记概述了使用 megaAVR® 0系列器件的入门说明。

有关使用 megaAVR® 0系列器件之间差异的更多信息，请参考数据手册。
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1. 相关器件
本章列出了文中涉及的相关器件。

1.1 megaAVR® 0 系列

下图所示为 megaAVR®0 系列器件，说明了引脚数变化情况和存储器大小：

• 在垂直方向移植时，由于这些器件的引脚和功能完全兼容，因此无需修改代码。

• 向左水平移植会减少引脚数，因此可用功能也会减少。

图 1-1. megaAVR® 0 系列概述
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具有不同闪存大小的器件通常也具有不同的 SRAM 和 EEPROM。
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2. 获取器件数据手册
网页

• http://www.microchip.com/wwwproducts/en/ATmega3208
• http://www.microchip.com/wwwproducts/en/ATmega3209
• http://www.microchip.com/wwwproducts/en/ATmega4808
• http://www.microchip.com/wwwproducts/en/ATmega4809

文档/文件

• megaAVR 0系列手册（.pdf）
• ATmega3208/4808 – 28 引脚数据手册（.pdf）
• ATmega3208/4808 – 32 引脚数据手册（.pdf）
• ATmega3209/4809 – 48 引脚数据手册（.pdf）
• megaAVR 0系列勘误表（.pdf）

使用 megaAVR® 0系列的文档分为三种类型：

• 手册（包括所有器件适用的器件说明）

• 数据手册 1（包括具体器件相关的所有信息——器件说明、外设数量、引脚排列和电气特性）

• 勘误表（包括器件的所有已知勘误项）

1 对于将来的器件（产品），将提供产品简介，不再提供数据手册。
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3. 获取工具

3.1 

使用 GCC 编译器的 Atmel Studio 7.0 是使用 megaAVR® 0系列入门的首选 IDE。

获取使用 ATmega4809 Xplained Pro 评估工具包

图 3-1. 使用 ATmega4809 Xplained Pro 工具包

DEBUG USB

POWER HEADER

EXTENSION 1 HEADER

EXTENSION 2 HEADER

EXTENSION 3 HEADER

ATmega4809

RESET BUTTON
CURRENT MEASUREMENT

HEADER
SW0 USER BUTTON

USER LED0

mikroBUS™ socket

AVR DEBUG
FOR EXTERNAL

DEBUGGER

ATECC508A
CRYPTO DEVICE

32.768kHz Crystal

TARGET VOLTAGE
SELECT HEADER

网页：http://www.microchip.com/developmenttools/productdetails.aspx?partno=atmega4809-xpro
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获取工具包：http://www.microchipdirect.com/ProductSearch.aspx?Keywords=atmega4809-xpro

文档/文件：

• 使用 ATmega4809 Xplained Pro （.pdf）

主要特性

• ATmega4809 单片机

• 可选择目标电压

– 3.3V
– 5.0V（USB/外部电源）

• 一个机械复位/用户可编程按钮

• 一个用户可编程的机械按钮

• 一个用户可编程的黄色 LED
• ATECC508 CryptoAuthentication™

器件

• 32.768 kHz 晶振

• 三个 Xplained Pro 扩展头

• 一个 mikroBUS™
插槽

• 带 UPDI 的 10 引脚、50 mil AVR 调试连接器

• 嵌入式调试器

– Atmel Studio 中用于电路板标识的 Auto-ID
– 一个黄色的状态 LED
– 一个绿色的电路板电源 LED
– 复杂数据类型的符号调试，包括范围信息

– 编程和调试，包括功率测量

– 数据网关接口：SPI、I2C 和四个 GPIO
– 虚拟 COM 端口（CDC）

• USB 供电

使用 ATmega4809 Xplained Pro 用户指南介绍了如何为工具包供电、关于板组件的详细信息、扩展接口和

硬件指南。
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3.2 获取 STK600 入门工具包

图 3-2. STK600 入门工具包

表 3-1. megaAVR 0系列的 STK600 器件支持

器件 路由卡 接插卡

ATmega3209 STK600-RC048M-107 STK600-QFN48

ATmega3209 STK600-RC048M-107 STK600-TQFP48

ATmega4809 STK600-RC048M-107 STK600-QFN48

ATmega4809 STK600-RC048M-107 STK600-TQFP48

关于对其他器件的器件支持，请参考：http://www.microchip.com/STK600_Starter_Kit-Users_Guide

网页：http://www.microchip.com/ATSTK600

获取工具包：http://www.microchipdirect.com/ProductSearch.aspx?Keywords=ATSTK600

文档/文件：

• STK600 用户指南（.pdf）

主要特性

• 与 AVR Studio 4/AVR32 Studio/AVR Studio 5/Atmel Studio 兼容

• PC 的编程和控制 USB 接口

• 由 USB 总线或外部 10-15V 直流电源供电

• 可调整目标 VCC（0-5.5V）
• 两个可调整的高精度参考电压（0-5.0V，10 mV 分辨率）

• 时钟振荡器，可在 Atmel Studio 中实时调整（0-50 MHz，0.1%分辨率）

• tinyAVR®
和 megaAVR®

器件的串行系统内编程（ISP）
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• AVR XMEGA®
器件的 PDI 编程

• megaAVR、AVR XMEGA 和 AVR UC3 器件的 JTAG 编程

• AVR UC3 器件的 aWire 编程

• 外部目标系统中 AVR 器件的 ISP 和 JTAG 编程

• 用于轻松安装所有受支持器件的灵活的路由卡和接插卡系统

• 八个通用按钮

• 八个通用 LED
• 所有 AVR I/O 端口均可通过引脚头连接器轻松访问

• 用于接插模块和原型开发区域的扩展连接器

• 用于非易失性数据的板上 4 Mb 数据闪存

• 适用于带 USB 的 AVR 器件的 USB mini-AB 实时连接器

• 用于 RS-232 接口的 PHY 和 DSUB-9 连接器

• 用于 CAN 总线的 PHY 和 DSUB-9 连接器

• 用于 LIN 总线的 PHY 和头

• 含 ATmega2560 AVR 单片机的器件板

3.3 

STK600 用户指南介绍了如何为工具包供电、关于板组件的详细信息、扩展接口和硬件指南。

从 Atmel | START 获取源代码
用户可以从 Atmel | START 获取示例代码。START 是一个基于 Web 的工具，让用户可以在图形化用户界

面（GUI）中配置应用程序代码。可以通过下面的直接示例代码链接或 Atmel | START 首页上的

“BROWSE EXAMPLES（浏览示例）”按钮来为 Atmel Studio7.0 和 IAR Embedded Workbench®
下载代

码。

Atmel | START 网页： http://microchip.com/start

示例代码

若想查找 megaAVR 0系列中器件的示例代码，请在 Atmel|START 示例浏览器中搜索器件名称（如

ATmega4809）。

欲了解示例项目的详情和信息，请按 Atmel | START 中的“User guide（用户指南）”按钮。在示例浏览

器中，可以通过在 Atmel | START 项目配置器中单击仪表板视图中的项目名称找到“User guide（用户指

南）”按钮。

Atmel Studio

在 Atmel | START 的示例浏览器中，通过单击“DOWNLOAD SELECTED EXAMPLE（下载所选示例）” 

以.atzip 文件格式为 Atmel Studio 下载代码。要从 Atmel | START 中下载文件，请单击“EXPORT 
PROJECT（导出项目）”，然后单击“DOWNLOAD PACK（下载数据包）”。

双击下载的.atzip 文件，这个项目将会导入到 Atmel Studio 7.0。

IAR Embedded Workbench

欲了解如何在 IAR Embedded Workbench 中导入项目的信息，请打开 Atmel | START 用户指南，选择 

“Using Atmel Start Output in External Tools（在外部工具中使用 Atmel Start 输出）”，然后选择 IAR 
Embedded Workbench。Atmel | START 用户指南链接可以通过单击 Atmel | START 首页中的“About（关

于）”找到，也可以通过单击项目配置器中的“Help And Support（帮助和支持）”找到，“About（关

于）”和“Help And Support（帮助和支持）”均位于页面的右上角。
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3.4 获取 Atmel Studio 7.0
网页： http://www.microchip.com/development-tools/atmel-studio-7

文档/文件：

• Atmel Studio 7.0（内部版本 1645）安装程序（.exe）

3.5 

3.6 

Atmel Studio 7.0 或更高版本是用于开发和调试使用 megaAVR® 0系列固件的首选 IDE。

关于器件支持，请参考 3.6  获取器件支持。

获取适用于 AVR 的 IAR 嵌入式工作台

网页： https://www.iar.com/iar-embedded-workbench/#!?architecture=AVR

文档/文件：适用于 AVR 的 IAR Embedded Workbench®
安装程序。

获取器件支持

Atmel Studio：可以通过 Device Pack Manager（器件包管理器）（可在 Tools->Device Pack Manager
中找到）增加对 Atmel Studio 中新器件的支持。

对于使用 megaAVR® 0系列，请执行下列步骤以更新到最新版本：

1. 单击 Check for Updates（检查更新）

2. 对于使用 megaAVR® 0系列，请选择可用的最新版 ATmega_DFP
3. 单击 Install（安装）

对于离线安装程序，请转到 http://packs.download.atmel.com/。要安装软件包，请双击安装程序文件并按

照说明进行操作。在安装生效之前，必须关闭任何打开的 Atmel Studio 窗口。

IAR：对 IAR 嵌入式工作台中新器件的支持可通过安装最新服务包获得。服务包可从 https://iar.com 上 My
Pages（我的页面）中下载。
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4. Atmel Studio 用户入门

4.1 Atmel Studio——带有 ATmega4809 Xplained Pro
先决条件

• 已安装 Atmel Studio 7.0 1645 或更高版本

• ATmega4809 Xplained Pro 板通过连接到嵌入式调试器的板上 USB 连接器连接到 Atmel Studio
7.0。该工具包采用 USB 供电，嵌入式调试器将通过 USB 使能调试和编程。

工作流

1. 启动 Atmel Studio 7.0。
2. 当 ATmega4809 Xplained Pro 连接到 Atmel Studio 7.0 时，将显示下图中所示的页面。

图 4-1. ATmega4809 Xplained Pro Atmel Studio 中的页面
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3. 单击New→Project...（新建 → 项目...）或者使用快捷方式 Ctrl+Shift+N，开始创建新项目，如下图所示。

图 4-2. 在 Atmel Studio 中创建新项目

4. 从New       Project（新建项目向导）（如下图所示）中选择 GCC        C Executable Project（GCC C 可执行项目）模              
    板，键入解决方案和项目名称（例如GETTING_STARTED 和 LED_TOGGLE），然后单击OK(确定)。

5. 从Device           Selection（器件选择向导）（如下图所示）中选择 ATmega4809，然后单击OK。
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图 4-4. Device Selection向导

将在 Atmel Studio 中生成一个新项目以及关联的 main.c 文件。

6. 将 main.c 文件中的 main loop 代码替换为以下代码片段：

int main (void)
{
/* Configure SW0 as input */
PORTB.DIRCLR = PIN2_bm;

/* Configure LED0 pin as output */
PORTB.DIRSET = PIN5_bm;

while (1)
{

/* Check the status of SW0 */
/* 0: Pressed */
if (!(PORTB.IN & (PIN2_bm)))
{

/* LED0  on */
PORTB.OUTSET = PIN5_bm;

}
/* 1: Released */
else
{

/* LED0 off */
PORTB.OUTCLR = PIN5_bm;

}
}

}

在代码编辑器中，该代码应如下图中所示。
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图 4-5. 代码编辑器窗口

7. 单击Project→Properties（项目→ 属性）或使用快捷方式 ALT+F7，打开项目属性。

8. 在Tool（工具）视图（见下图）中，将Selected           Debugger/Programmer(选定调试器/编
程器)设置为 mEDBG，将Interface(接口)设置为 UPDI。
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图 4-6. 调试器和接口 ATmega4809

9. 单击Build→Build Solution(构建 → 构建解决方案)或使用快捷方式 F7，开始构建项目。

10. 单击Debug → Start debugging and break(调试 → 开始调试和中断)或使用快捷方式 ALT+F5，使用

项目代码对 ATmega4809 进行编程并开始调试。应用将编程到器件，程序执行应中断 main 代码。

11. 单击Debug → Continue(调试 → 继续)或使用快捷方式 F5 运行代码。

12. 确认在 ATmega4809 Xplained Pro 上按下 SW0 时 LED0 亮起。

4.2 Atmel Studio——带有 STK600
先决条件

• 已安装 Atmel Studio 7.0 1645 或更高版本

• STK600 板通过板上 USB 连接器连接到 Atmel Studio 7.0。

工作流程

1. 启动 Atmel Studio 7.0。
2. 单击 New → Project…或者使用快捷方式 Ctrl+Shift+N，开始创建新项目，如下图所示。
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图 4-7. 在 Atmel Studio 中创建新项目

3. 从 New Project 向导（如下图所示）中选择 GCC C Executable Project 模板，键入解决方案和项目

名称（例如 GETTING_STARTED 和 LED_TOGGLE），然后单击 OK。
图 4-8. 新建项目向导

4. 从 Device Selection 向导（如下图所示）中选择 ATmega4809，然后单击 OK。
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图 4-9. Device Selection向导

将在 Atmel Studio 中生成一个新项目以及关联的 main.c 文件。

5. 将 main.c 文件中的 main 函数替换为以下代码片段：

int main (void)
{
/* STK600 have eight User Buttons and eight User LEDs which can be connected to any IO

pin using cables */
/* Configure PB0 as input (remember to connect SW0 to PB0 using a cable */
PORTB.DIRCLR = PIN0_bm;

/* Configure PB1 as output (remember to connect LED0 to PB1 using a cable*/
PORTB.DIRSET = PIN1_bm;

while (1)
{

/* Check the status of SW0 */
/* 0: Pressed */
if (!(PORTB.IN & (PIN0_bm)))
{

/* LED0 on */
PORTB.OUTCLR = PIN1_bm;

}
/* 1: Released */
else
{

/* LED0 off */
PORTB.OUTSET = PIN1_bm;

}
}

}

在代码编辑器中，该代码应如下图中所示。
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图 4-10. 代码编辑器窗口

6. 单击 Project → Properties 或使用快捷方式 ALT+F7，打开项目属性。

7. 在 Tool 视图（见下图）中，将 Selected debugger/programmer 设置为 STK600，将 Interface 设置

为 UPDI。
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图 4-11. 调试器和接口 ATmega4809

8. 单击 Build → Build Solution 或使用快捷方式 F7，开始构建项目。

9. 如下图所示，通过连接 ISP/PDI 头之间的电缆，将 STK600 上的嵌入式调试器连接到

ATmega4809。
图 4-12. STK600 上的 UPDI 连接

10. 使用电缆将 PB2 连接到 SW0，将 PB5 连接到 LED0。
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11. 将代码加载到 STK600，然后单击 Debug → Start debugging and break 或使用快捷方式 ALT+F5 开

始调试。应用将编程到器件，程序执行应中断 main 代码。

12. 单击 Debug → Continue 或使用快捷方式 F5 运行代码。

13. 确认在 STK600 上按下 SW0 时 LED0 亮起。
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5. 后续步骤
关于相关 AVR 产品和 IDE 的更多信息，请参见下面的链接：

软件：

• Atmel Studio： http://www.microchip.com/avr-support/atmel-studio-7
• Atmel Studio 帮助：“Help → View Help（帮助 → 查看帮助）”（快捷方式：“CTRL+F1”）

• Atmel Gallery： https://gallery.microchip.com/

固件：

• Atmel START 文档： http://start.atmel.com/static/help/index.html
• Atmel START 示例： http://microchip.com/start/#examples

硬件：

• AVR042：AVR 硬件设计注意事项：http://www.microchip.com/
AVR042:AVR_Hardware_Design_Considerations

• AVR IBIS 文件： http://www.microchip.com/doclisting/TechDoc.aspx?type=IBIS
• AVR BDSL 文件： http://www.microchip.com/doclisting/TechDoc.aspx?type=BSDL

推荐的编程/调试工具：

• Atmel-ICE：
– 文档：http://www.microchip.com/Atmel-ICE_Debugger_User_Guide
– 购买： http://www.microchip.com/developmenttools/productdetails.aspx?partno=atatmel-ice

• Power Debugger：
– 文档：http://www.microchip.com/42696D_Power_Debugger_User_Guide
– 购买： http://www.microchip.com/developmenttools/productdetails.aspx?

partno=atpowerdebugger

其他：

• AVR Freaks®
： http://www.avrfreaks.net/

• 应用笔记：http://www.microchip.com/paramChartSearch/chart.aspx?branchID=30047，查找首选器

件并转到产品页。所有相关的应用笔记可在文档选项卡下找到。

• AVR 产品选型： http://www.microchip.com/paramChartSearch/chart.aspx?branchID=30047
• 关于不同产品的更多技术文档： http://www.microchip.com/webdoc/
• Microchip 技术支持： http://www.microchip.com/support/hottopics.aspx
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6. 版本历史

文档版本 日期 备注

A 02/2018 初始文档版本
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Microchip 网站

Microchip 网站 http://www.microchip.com/为客户提供在线支持。客户可通过该网站方便地获取文件和信

息。只要使用常用的互联网浏览器即可访问，网站提供以下信息：

• 产品支持——数据手册和勘误表、应用笔记和示例程序、设计资源、用户指南以及硬件支持文档、最

新的软件版本以及归档软件

• 一般技术支持——常见问题（FAQ）、技术支持请求、在线讨论组以及 Microchip 顾问计划成员名单

• Microchip 业务——产品选型和订购指南、最新 Microchip 新闻稿、研讨会和活动安排表、Microchip
销售办事处、代理商以及工厂代表列表

变更通知客户服务

Microchip 的变更通知客户服务有助于客户了解 Microchip 产品的最新信息。注册客户可在他们感兴趣的某

个产品系列或开发工具发生变更、更新、发布新版本或勘误表时，收到电子邮件通知。

欲注册，请登录 Microchip 网站 http://www.microchip.com/。在“支持”（Support）下，点击“变更通知

客户”（Customer Change Notification）服务后按照注册说明完成注册。

客户支持

Microchip 产品的用户可通过以下渠道获得帮助：

• 代理商或代表

• 当地销售办事处

• 应用工程师（FAE）
• 技术支持

客户应联系其代理商、代表或应用工程师（FAE）寻求支持。当地销售办事处也可为客户提供帮助。本文

档后附有销售办事处的联系方式。

也可通过以下网站获得技术支持： http://www.microchip.com/support

Microchip 器件代码保护功能

请注意以下有关 Microchip 器件代码保护功能的要点：

• Microchip 的产品均达到 Microchip 数据手册中所述的技术指标。

• Microchip 确信：在正常使用的情况下，Microchip 系列产品是当今市场上同类产品中最安全的产品

之一。

• 目前，仍存在着恶意、甚至是非法破坏代码保护功能的行为。就我们所知，所有这些行为都不是以

Microchip 数据手册中规定的操作规范来使用 Microchip 产品的。这样做的人极可能侵犯了知识产

权。

• Microchip 愿意与关心代码完整性的客户合作。

• Microchip 或任何其他半导体厂商均无法保证其代码的安全性。代码保护并不意味着我们保证产品是

“牢不可破”的。

代码保护功能处于持续发展中。Microchip 承诺将不断改进产品的代码保护功能。任何试图破坏 Microchip
代码保护功能的行为均可视为违反了《数字器件千年版权法案（Digital Millennium Copyright Act）》。如
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果这种行为导致他人在未经授权的情况下，能访问您的软件或其他受版权保护的成果，您有权依据该法案

提起诉讼，从而制止这种行为。

法律声明

本出版物中所述的器件应用信息及其他类似内容仅为您提供便利，它们可能由更新之信息所替代。确保应

用符合技术规范，是您自身应负的责任。Microchip 对这些信息不作任何明示或暗示、书面或口头、法定或

其他形式的声明或担保，包括但不限于针对其使用情况、质量、性能、适销性或特定用途的适用性的声明

或担保。Microchip 对因这些信息及使用这些信息而引起的后果不承担任何责任。如果将 Microchip 器件用

于生命维持和/或生命安全应用，一切风险由买方自负。买方同意在由此引发任何一切伤害、索赔、诉讼或

费用时，会维护和保障 Microchip 免于承担法律责任，并加以赔偿。除非另外声明，否则在 Microchip 知识

产权保护下，不得暗中或以其他方式转让任何许可证。

商标

Microchip 的名称和徽标组合、Microchip 徽标、AnyRate、AVR、AVR 徽标、AVR Freaks、BitCloud、 

chipKIT、chipKIT 徽标、CryptoMemory、CryptoRF、dsPIC、FlashFlex、flexPWR、Heldo、JukeBlox、 

KeeLoq、Kleer、LANCheck、LINK MD、maXStylus、maXTouch、MediaLB、megaAVR、MOST、 

MOST 徽标、MPLAB、OptoLyzer、PIC、picoPower、PICSTART、PIC32 徽标、Prochip Designer、 

QTouch、SAM-BA、SpyNIC、SST、SST 徽标、SuperFlash、tinyAVR、UNI/O 和 XMEGA 是 Microchip 
Technology Incorporated 在美国和其他国家或地区的注册商标。

ClockWorks、The Embedded Control Solutions Company、EtherSynch、Hyper Speed Control、 

HyperLight Load、IntelliMOS、mTouch、Precision Edge 和 Quiet-Wire 为 Microchip Technology 
Incorporated 在美国的注册商标。

Adjacent Key Suppression、AKS、Analog-for-the-Digital Age、Any Capacitor、AnyIn、AnyOut、 

BodyCom、CodeGuard、CryptoAuthentication、CryptoAutomotive、CryptoCompanion、 

CryptoController、dsPICDEM、dsPICDEM.net、Dynamic Average Matching、DAM、ECAN、 

EtherGREEN、In-Circuit Serial Programming、ICSP、INICnet、Inter-Chip Connectivity、JitterBlocker、 

KleerNet、KleerNet 徽标、memBrain、Mindi、MiWi、motorBench、MPASM、MPF、MPLAB Certified
徽标、MPLIB、MPLINK、MultiTRAK、NetDetach、Omniscient Code Generation、PICDEM、 

PICDEM.net、PICkit、PICtail、PowerSmart、PureSilicon、QMatrix、REAL ICE、Ripple Blocker、SAM-
ICE、Serial Quad I/O、SMART-I.S.、SQI、SuperSwitcher、SuperSwitcher II、Total Endurance、 

TSHARC、USBCheck、VariSense、ViewSpan、WiperLock、Wireless DNA 和 ZENA 为 Microchip 
Technology Incorporated 在美国和其他国家或地区的商标。

SQTP 为 Microchip Technology Inc.在美国的服务标记。

Silicon Storage Technology 为 Microchip Technology Inc.在除美国外的国家或地区的注册商标。

GestIC 是 Microchip Technology Inc.的子公司 Microchip Technology Germany II GmbH & Co. KG 在除美

国外的国家或地区的注册商标。

在此提及的所有其他商标均为各持有公司所有。

© 2018, Microchip Technology Incorporated 版权所有。

ISBN：978-1-5224-3937-0
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DNV 认证的质量管理体系

ISO/TS 16949
Microchip 位于美国亚利桑那州 Chandler 和 Tempe 与位于俄勒冈州 Gresham 的全球总部、设计和晶圆生

产厂及位于美国加利福尼亚州和印度的设计中心均通过了 ISO/TS-16949:2009 认证。Microchip 的 PIC®

MCU 和 dsPIC® DSC、KEELOQ®
跳码器件、串行 EEPROM、单片机外设、非易失性存储器和模拟产品严

格遵守公司的质量体系流程。此外，Microchip 在开发系统的设计和生产方面的质量体系也已通过了 ISO
9001:2000 认证。
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美洲 亚太地区 亚太地区 欧洲

公司总部

2355 West Chandler Blvd.
Chandler, AZ 85224-6199
电话：480-792-7200
传真：480-792-7277
技术支持：

http://www.microchip.com/
support
网址：

www.microchip.com
亚特兰大

杜鲁斯市，乔治亚州

电话：678-957-9614
传真：678-957-1455
奥斯汀，德克萨斯州

电话：512-257-3370
波士顿

伍斯特，马萨诸塞州

电话：774-760-0087
传真：774-760-0088
芝加哥

艾塔斯卡，伊利诺伊州

电话：630-285-0071
传真：630-285-0075
达拉斯

艾迪生，德克萨斯州

电话：972-818-7423
传真：972-818-2924
底特律

诺维，密歇根州

电话：248-848-4000
休斯顿，德克萨斯州

电话：281-894-5983
印第安纳波利斯

诺布尔斯维尔，印地安纳州

电话：317-773-8323
传真：317-773-5453
电话：317-536-2380
洛杉矶

米申维耶霍，加利福尼亚州

电话：949-462-9523
传真：949-462-9608
电话：951-273-7800
罗利，北卡罗来纳州

电话：919-844-7510
纽约，纽约州

电话：631-435-6000
圣荷西，加利福尼亚州

电话：408-735-9110
电话：408-436-4270
加拿大 - 多伦多

电话：905-695-1980
传真：905-695-2078

澳大利亚 - 悉尼

电话：61-2-9868-6733
中国 - 北京

电话：86-10-8569-7000
中国 - 成都

电话：86-28-8665-5511
中国 - 成都

电话：86-23-8980-9588
中国 - 东莞

电话：86-769-8702-9880
中国 - 广州

电话：86-20-8755-8029
中国 - 杭州

电话：86-571-8792-8115
中国 - 香港特别行政区

电话：852-2943-5100
中国 - 南京

电话：86-25-8473-2460
中国 - 青岛

电话：86-532-8502-7355
中国 - 上海

电话：86-21-3326-8000
中国 - 沈阳

电话：86-24-2334-2829
中国 - 深圳

电话：86-755-8864-2200
中国 - 苏州
电话：86-186-6233-1526
中国 - 武汉

电话：86-27-5980-5300
中国 - 西安

电话：86-29-8833-7252
中国 - 厦门

电话：86-592-2388138
中国 - 珠海

电话：86-756-3210040

印度 - 班加罗尔

电话：91-80-3090-4444
印度 - 新德里

电话：91-11-4160-8631
印度 - 浦那

电话：91-20-4121-0141
日本 - 大阪

电话：81-6-6152-7160
日本 - 东京

电话：81-3-6880- 3770
韩国 - 大邱

电话：82-53-744-4301
韩国 - 首尔

电话：82-2-554-7200
马来西亚 - 吉隆坡

电话：60-3-7651-7906
马来西亚 - 槟榔屿

电话：60-4-227-8870
菲律宾 - 马尼拉

电话：63-2-634-9065
新加坡

电话：65-6334-8870
台湾地区 - 新竹

电话：886-3-577-8366
台湾地区 - 高雄

电话：886-7-213-7830
台湾地区 - 台北

电话：886-2-2508-8600
泰国 - 曼谷

电话：66-2-694-1351
越南 - 胡志明
电话：84-28-5448-2100

奥地利 - 韦尔斯

电话：43-7242-2244-39
传真：43-7242-2244-393
丹麦 - 哥本哈根

电话：45-4450-2828
传真：45-4485-2829
芬兰 - 埃斯波

电话：358-9-4520-820
法国 - 巴黎

电话：33-1-69-53-63-20
传真：33-1-69-30-90-79
德国 - 加兴

电话：49-8931-9700
德国 - 哈恩

电话：49-2129-3766400
德国 - 海尔布隆

电话：49-7131-67-3636
德国 - 卡尔斯鲁厄

电话：49-721-625370
德国 - 慕尼黑

电话：49-89-627-144-0
传真：49-89-627-144-44
德国 - 罗森海姆

电话：49-8031-354-560
以色列 - 赖阿南纳

电话：972-9-744-7705
意大利 - 米兰

电话：39-0331-742611
传真：39-0331-466781
意大利 - 帕多瓦

电话：39-049-7625286
荷兰 - 德卢内市

电话：31-416-690399
传真：31-416-690340
挪威 - 特隆赫姆

电话：47-7289-7561
波兰 - 华沙

电话：48-22-3325737
罗马尼亚 - 布加勒斯特

电话：40-21-407-87-50
西班牙 - 马德里

电话：34-91-708-08-90
传真：34-91-708-08-91
瑞典 - 哥德堡

电话：46-31-704-60-40
瑞典 - 斯德哥尔摩

电话：46-8-5090-4654
英国 - 沃金厄姆

电话：44-118-921-5800
传真：44-118-921-5820

全球销售及服务网点
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